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CUB.X Presentation

All the data used in the examples are totally fictitious. Some of the screens are
designed solely to enhance explanation or decument composition and so may
be different from reality.

The CUB.X program for Windows is a tool for exploiting statistical mufti-
dimensional tables.

CUB.X is the property of Evurostat. This software can be used for your needs,
free of charge, but cannot be resold. It may not be used for commercial gain or
distributed without prior authorisation by Eurostat.

Information in this document and the content of all CUB.X files are subject to
change without notice and do not represent a commitment on the part of
Eurostat.

Information in this document and the content of 2ll CUB.X files are subject to
change without notice and do not represent a commitment on the part of
Eurostat. We shall not be liable for editorial omissions made herein ; nor for
incidental or consequential damages resulting from the misuse of the CUB.X
program.

COPYRIGHT ©®

This manual may net, in whole or in part, be photocopied, reproduced,
transcribed, translated, or transmitted in whatsoever form without the written
consent of Eurostat, except for copies retained by the user of CUB.X for
personal archival purposes.

COPYRIGHT © 1996 Eurostat. All rights reserved.

A full Cub.X manual is available on reguest.



Conventions

J@ » means : sefect using the mouse.
» means : select using the keys.

@ » means : use MS-Windows features

REMEMBER ! Under the MS-Windows environment :

» J@ click to reduce a window (put the window in background)

> ‘/@ click to reduce or restore a window

To exit any program running under MS-Windows :

> ALT+F4  -or-

J@ » Double-click the System Menu {%
the active window.

) in the upper left corner of

» means : use the arrow keys {io scroll, etc.).

{if you are using the numeric keypad,
make sure NUM LOCK is off before
using it).

Y €>
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Installation procedure

#f MS5-Windaows is not already running, type Win at the DOS prompt.
First, to prevent eventual incidents or errors (like formatting the disketts...),

make a copy of the distribution diskette using the MS-DOS Diskcopy command
or the Copy Disk option from Windows File Manager.

insert the CUB.X for WIN installation diskette in your diskette drive

his pE

“B % From the File menu, choose Run » (ALT, F. R)

Type : al\setup.exe. (or d:/setup if you are running setup from the CD-ROM}.

When the program asks you for the target directory, click OK to accept
c:\refer.win directory by default {or type any cther directory).

The installation procedure creates the "New Cronos Software” program group.

The icons of the CUB.X Program are the following :

CUBx for the program
Browser

d for the Hel stem.
N B X hep O e MEIP SY



Working with Cub.X

If Windows is not already running, at the system prompt, type win and then
press Enter.

aas
In the Program Manager, double-click the "New Cranos Software” A¥s
group icon or the group icon that contains Cub. X New Cronos
Coftware

"/6 > Double-click the CUB.X Browse icon i
CUE &
Broveser
=0r-
>  Select the CUB.X Browse icon using the arrow keys,
then press Enter

From the File menu, choose Exit P O(ALT, R, X)

Use the "exit" feature of MS-Windows




The data file

“B >  From the File menu, choose Open > (ALT.F, O)

The fallowing dialeg box appears :

A : type or select
the file you want to
open.

. File Hame: Directesies;

— T ciusrtravail\fichisrbutilise

example. cbx 3 = ] e
example. dft .
prample. %‘::wail B_ : ;elect a new
product, cbe aa drive, if necessary.
product dit > tichior
view.chx P utilise
= 2 themel ] C : select a new
 List Fios of Type: Drwer ' directory, if neces-
= 1" chx :g c: fantG0 . sary.
A B C

(VIS

Cheoose the OK button.

See also “Many views, one datafile” (Working with views) on page 18-19.

‘/@ > From the File menu, choose Close. > (ALT.F,C)
Then . open a data file as above

B > From the "Information and Help” menu, ¥ (ALT, LD
choose Information on the table

Warning ! Data files may not have this additional information.

Note : when you open a data file, an "Information and Help” window may open
automatically, and hide a part of the .DFT window: it gives you additiona!

information on the table, the origin of values, dimensions.... should vour table
has an additional information file.




The index file

An index is a file that organizes your data and allows you quicker access to
them. If your tables have a fot of data, it is necessary to use an index with the
fable.

If you don't really know how to work with an index,
> do not delete the first index you receive, and

o do not activate the command confirm index in the
Options menu.

CUB.X will automatically read the index when you open the
data file.

If you decide not 1o use the index for a particular reason, you can activate an
option that will ask you if you want to use the index, each time you cpen a table.

"/Ej »> Before opening the file *.DFT, click the Options menu and look at
Confirm index

If the command is checked ('/), the index confirmalion is active. So, the index is
NOT automatically used . you will have to confirm its use. A confirmation
message wiil appear.

If the command is not checked , it means that the index confirmation is not
active. So, the indax will be used without notice.



Consultation of a data file :

screen description

Cub.X is organised |like a page of a spreadsheet ; it allows data to be viewed,
selected and exported. The window shows only a part of the page that may
contain mare rows and celumns than ¢an be displayed on the screen.

= Edit Pres

‘eeccountry i iproduct

L

hananas

@ Complete name of the current file @ X axis, one of the dimensions
@ Number of cells ® Y axis, one of the dimensions
@ Data presentation ® Horizontal scroll bar

@ Dimension blocks

@ Current file name
Orive, directories and file names are between 2 square brackets.

() Number of cells

The first number (2304/...) is the number of selected cells with
second (...f2304) is the number of all the cells defined in the file.

; the

@  Data presentation
The intersection of the X and Y axes, and also the selected positions in
each other dimension block (set of positions - see page 9).

@ X axis
Horizontal axis. A value of the X axis defines a column.
® Y axis

Vertical axis. A value of the Y axis defines a row.

®  Horizontal {vertical) scroll bar
Appears when the window size doesn't allow the whole table to be
displayed.

@ Dimension blocks



command line | [eeccountry [Y] +— tithe of the
for data S - dirmension
resentation | ‘
P ryre ; ofigin of the
it S T dimension
laked of e o
the origin — 1 iUmiesd Kingdony
Axis (X or Y) Labels
Indicates that the dimension is “Removes” all the dimensien
used as X or Y axis. labels. To display all the

Information

jabels, use the command
Options/Labels.

Select / Unselect positions

Gives you more information about Allows you to select or

the dimension and its positions. unselect positicns of the

Go forward

of the dimension.

[UK

United Kingdom

dimension. Useful for
exporting a subset of the
data.

Go back

Go to the next position(s) " Go to the previous position(s)

of the dimension.

Title of the dimension

Name of the dimension, This name corresponds to the
associated dictionary {(eeccountry.dic, for instance).

Origin of the dimension

This button allows you to select directly any position
you want to see. By clicking this buitton, the list of all
the positions appears. Click on one of them to select it.

Label of the origin

When CUB.X finds the assocciated dictionary of a data
file, it puts the labels in this box. If you don't see the
entire label, click on it : the label will appear in a label
box.



Displaying data

It is useful o be able to rotate axes to see better some set of values. in the

following figure, the arrow shows you where you have to click to swap the two
axes.

Presentation Dictionary Options Export [nformation and Helgp

| lorigin | |product Y] [eeccountry [X
d EEEEE

. 5726 . BABT
50.35 : 38.09 7461 !

617

N T M TS T

P AR B A K 00 0

i

This cemmand allows you to have only one file with one multi-dimensional table,
but many views of the data.

Three ways are provided to do this very impertant manipulation :

& drag and drop a dimension title toward an axis.
(® drag and drop a dimension block title towards another one.
® use keyboard shortkeys to change quickly the place of each dimension.



i File Edit _Eresenlalinn Qlclinnary Oplmns” Export j_nfbrmailon and Help

Move cursor to the title of the dimension block. Click and hold down the left
button, drag towards an axis, and drop (by releasing the mouse button).

Note : this option is applies only to dimensions other than X and Y.

In this example, preduct becomes the new X axis, and time wiil take the previous
place of product. The order of the other dimensions is reorganised.

» CTRL + R to shift the » CTRL + L to shift the
dimension blocks to the dimension blocks to the
right left.

Y -, :I > g v] » - elpod & [piyin ¥ {_hme
- /ﬁ FEEEEE ..{ g mn & ml:ﬂ‘i
Ban] - | ——1 Bangf ] Eemingtom | [ ]

1"



»  PressCTRL+ G

First, you have to decide what you want to present on the chart.

~—  The X axis of the table will be the X axis of the chart, in the example
below the countries.

—_ The selected position of the Y dimension will define the ¥ axis. In the
example below, the pesition mushroom will be the dimension product.

—  The current line of the table {the line where the cursor is) will be
represented on the chart.

File Edit Pmscntalmn”Dldlnnary Optlnns Expun lntnrmallonandHelp

time origin | [product Y] eeccuuntry I)(I

BRE3FSWEE TR
eec |

7001 eer
! | [Coming from

E6.1F

Y axis : Values
EY|

T Y
¥ axis '.‘.‘ee,émmtry
4 55
| i 1 T T I | | 1 1 |
it de dn i nl

fr H el 1 be: po

8

1
68
61
54
17
39
i
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OO e O e e
= soooasaasSs
\‘\.
H
5
.
.

Note : Cub.X is not designed for charting : this is a rough and ready facility for
providing a graphical view of the selected data. Making more complex charts,
data manipulation and calculation, is left to your preferred software. {See
“Export manipulfation® page 23).

#  Click this button to reverse the axes order on the chart sheet
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“B >  From the Options menu, choose Justify. > (ALT, O, )

You can chose between 3 options : Left , Center or Right Justify. The alignment
you choose will be kept for the next session of CUB. X whichever file you open.

"/Ej > From the Options menu, choose Table, > (ALT,O0,T)

You can chose between 3 options. The option that you cheose will be kept for
the next session of CUB.X whichever fite you open.

To activate all the labels for all the dimension :

‘B >  From the Options menu, check the > (ALT, O, L)
command Labels

Table with labels activated :
5
il

%
%

Table without
labels activated :




&
&

Y

to display again all the dimension labels.

becomes .

You can selectively activate the labels of only some of the dimensions.

If you want few labels, it is better to remove the check mark of the menu
Options/ Labels , whereas if you want a lot of labels, it is better to check this
opticn.

"/Ej »  Point to the labe! on the dimension block, click and hold down the
left butten of the mouse.

J@ »  Point to the label in the table, click and hold down the left button of
the mouse,

> Release the feft button and the label disappears.

Example :

| o

g C.orr.ling

frnm outside the EEC - o ﬁ

| B0,
: GipA] 3091 ] 50.39 230 729 | U048 31".’"

‘% »  From the Options menu, choose > (ALT, O, D)
Decimals

14



J@ »  From the Options menu, choose
Columns/Rows

> Use the mouse to select a size in one of the dialog boxes

» {ALT. O, C)

OR > Use the mouse to size directly one row and/or one column :

B
3
3

=
3

3
R
3
S

‘/6 » From the Presentation menu, choose
Restore native order

» (ALT,P,N)

"% > From the Presentation menu, choose
Reset ranges

> (ALT,P,E)

> From the Presentation menu, choose
Refresh screen

» (AT P,R)

‘% » From the Options menu, choose
Language

> Select one Language

» (ALT, O, L™,
Vor )

Press Enter

Refer also to “Dictionary manipulation”.
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J@ > Click on the |###] button of the corresponding dimension block.

This dialog box appears ;

@ » This box displays all the
selected positions of the
dimension (the positions to
be shown on the screen).

Paosiliong

@ ¥ This box displays all the
unselected positions of the
dimension (the positions
not to be seen on the
screen).

The button @ allows you to move the highlighted positions from box @
to box @ : these positions will be unselected and not shown.

The button @ allows you to move the highlighted positions from box @
to box O : these positiens will be (re-)selected and shown.

By clicking one of the buttons & - or @ -, a dialeg box appears. In this
dialog box, you can enter an expression, called a regular expression,
that allows you to activate positions (highlighted positions) te be
selected in box @, - orin box @ respectively -

By clicking one of the buttons ® - or ® -, a dialog box appears which
allows you to deactivate some highlighted positions, from box @, - or
from box @ respectively - The mechanism of regular expressions is
used (cancel some selections made in box @, - or in box @-).

This button validates all your Cancel any previous
changes. operations in this
dialog box.

These selection(s) do not imply that your values will be deleted from the
table.

You will find a detailed explanation of regular expressions and their use
in the Memo on page 28.




Example

Initially, alf the dimensions values can be seen. Suppose you may want to see
only some of the position.

To unselect some positions :

1 Click in the dimension block to unselect some positions.

2 In the selected positions box @, click all the products you don't want to
see, to unselect them

3 Click {: the highlighted products are transferred automatically to the

unselected positions box.
4 Click OK

The result is the same table with only the positions that interest you.

i
E

TR TR PR PRI FFFFRNFEFRFEIFFAR FANFEY,

E'res.enta'tlon -Qlchﬁ-l-wry Qptions

E
B
H
kime | forigin | [eeccount Yl
:
!
i

plERE izl (D B3R
|Curningrom | Espana _
' i

S

i P O A

To re-select those positions, you just have to do the same thing in box @ and

click |




Many views, one datafile

Introduction

A view allows you to have a certain way of looking at your data, specifying a
presentation and sefection. It is similar to saving your file with another name ;
but saving a view {.CBX) is much more interesting than saving a file { DFT).

J@ » From the File menu, choose Open > (ALT,F. O)

Select the view that you want to open (a name followed by the extension CBX).
The view opens the corresponding data file with the data represented as you

choose.

To store a view on your hard disk :
J@ > From the Presentation menu, choose » (ALT, P, V, 8)

View.
Then choose the option Save a view

é Warning ! Make sure that the file keeps the extension .CBX.




Working with views

You have two ways to work with an existing view of a file :

= You open directly the view (.CBX), instead of opening the data file (.DFT).

o> You open the data file (.DFT), and then, when you need it, you load the
attached view.

“B >  From the Presentation menu, choose > (ALT,P.V,L)
View.
>  Then choose the option Load a view.

When you release the mouse
button, CUB.X allows you to save
current changes in a new view :

If you want to save it, follow the instructions of the paragraph "To save a view".

A dialog box appears, asking you to choose the view { CBX} that you want to
load in the file list box, for example, PRODUCT.CBX.

You are in the same data file, but with another "View".

You can load many views in a CUB.X session {one at a time).

Note : you can't load a
view that is not
aftached to the open
data fite because a
view is linked to a
unique data file. In
case of mismatch, you
get this message :

19



Dictionary manipulation

Introduction

When you see the dimensions with their corresponding labels, it means that
CUB.X has found the dictionaries and associated them with each dimension. All
the following conditions have to be respected :

= the assaociated files .DIC exist.

= the dimension and the file .DIC have the same name. The file name is
limited to 8 characters. So, far example, for the dimension "eeccountry”,
the corresponding dictionary will be "eeccount.dic”.

= CUB.X finds the dicticnaries in the defined directory built automatically
frem the dictionary root. If CUB.X doesn't find any dictionaries, you have
to indicate where they are stored. (See also page 22 : "Change dictionary
root”).

Checking dictionary

J@ »  From the Dictionary menu, choose > (ALT.D, Iy
Dimension

This dialog box appears,
and you can verify each |
dimension : Dictionaries associaled with dimension :

eeccountry ! elcubxwin\demoleeccountry.dic

The storing of dictiona- product i ccubx.wintdemo\product.dic
ries follows the same origin ! cheubx.winjdemolorigin.dic
logical structure as the tme

data files.

20



‘B » From the Dictionary menu, choose » (ALT, D, E)
Search path for the labels

There are many paths, because there are a lot of possibilities to store these
files. CUB.X builds these paths from the root directory which is the basic
directory used to find .DIC file for each dimension ; (to build the roct dictionary,
see the next page).

Example :
In this figure, you can see all the paths that CUB.X builds and where it searches

for the labels (the fites .DIC) to associate them with each corresponding
dimension.

Order of searching *abels files™ :

root is I cicubx.winidemo

cloubx.wintidemoldocien\base_example\domain_sxampleicoile ction_cub.x
: cleubx.winjdemoldoclenibase exampleldomain_example

: ccubx.winldemolidocienibase example

: cAcubx.winldemoldecien

: cocubx.wintidemotbase_exampleldomain_examplelcollection_cub.x

: cAcubx.win\demo\base_exampleldomain_example

! chcubx.winldemotbase_example

: cleubx.win\demol

= T T e P =

The chesen language is English ; in the path, you can see “en”, because the
English dictionaries are in the directory "en™.

In accardance with the selected language (Optiens/Language), CUB.X builds the
paths and can open the dictionary in the corresponding language.

For example, choose the language French. To check the new path, chocse the
command Search path for labels from the menu Dictionary. The "en” from the
previous figure has beceme "f".

Refer to "Displaying data”
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‘% »  From the Dictionary menu, choose » (ALT, D, D)
Cictionary root.

» Choose the dictionary directory

The dictionary mechanism is activated from the directory root. This top directory
is the basic directory which is used to find the .DIC file for each dimension.

Example
@ Choosethedrive = @ Go on the root 2 @ Choose the "top”
where Cub. X will of the drive directory of the

find the dictionaries.

dictionaries

....... #
- il ]
Jus1]

JrusLnip|
-

llanconiig]
: {[nfe]
|Inctzcape]

When you are on the root of the drive, and see all the top directories of the drive,
select the top directory where the dictionaries are stored, but don't go further..

The screen shows you the directory used for the demo example, which possibly
doesn't correspond to the directory of your data files.

1 Click {only onca) on the top dictionaries' directory, to select it.

2 Click OK

When you select the root directory, you must stay on the main directory without
going further because Cub.X builds the path automatically. If you should go
deeper in the tree structure, Cub.X will build an erroneous path.

22



Export manipulation

é important before exporting data

Exporting a lot of data can use up a lot of resources and risks freezing your PC
for a very long time.

Number of cells te export = number of selected cells

It is batter and faster fo export several two-dimensional tables
(the displayed XY table that interests you),
rather than a large multi-dimensicnal table,

Introduction

You use the Cub.X command Export to export data or to be able to read data in
different formats. Remember that whatever method you choose to export data,
only the selected data will be exported.

Two ways to export data to be used in ancther application are provided :

@ Use the Windows’ Clipboard
@ Use the Export facility

® # Windows' Clipboard

“B >  From the Edit menu, choose » (ALT, E, A)
Copy XY all

J@ »  From the Edit menu, choose the » (ALT,E, 8)
command Copy XY selected

23



@ Export facility

Export multi-dimensional tables

J@ »  From the Options menu, see the command
XY export mode (otherwise All)

= To export XY, the command must be checked.

Click the menu Export, and choose the target file format.

Type a new name for the target file.

"@ » From the Opticns menu, see the command
XY export mode (otherwise All)

= To export all the data, the command must be NOT checked.

Click the menu Export, and choose the target file format.

Type a new hame for the target file.

Note : if labels are not displayed, they will not be exported. Please see "Display
data”.

é Do net use reserved extensions like .XLS, .DOC, etc. It is better 1o make the
distinction between your exportaticn files and other applications files.

24



Export formats

B » Fromthe Export menu, » (ALT, X, Vora)
Choose the export format you want to use : Table, Stream or Eurostat
¥ select again between ¥ (> ¥orA)
the options provided Press Enter

Table : three different table formats are available.

DIF

EXCEL/TAB

csyv

Data Interchange Format
Only for XY tables and accepted by most of the well-known
spreadsheets on the market,

This option allows tables te be input to the EXCEL system. In
fact, this format is a “tab delimited” format, each cell being
enclosed by a double quotation mark <"> and separated with a
<tab>.

Comma Separated Values

This format is the same as that of EXCEL except that the
delimiter between all fields is the comma <,>.

This kind of file is accepted, for instance, by the IMPROV
program.

Stream : three different kinds of file are available.

dBASE

Text

csv

Eurostat :

Accepted by dBASE software, this file has X + 1 fields with
X = number of dimensions
1 = value (last field).

This format is a text file with X + 1 columns

X = number of dimensions

1 = value {last column)

The separator between columns is a <space>.

Same format as Text but using double quotation marks <'> to

enclose the contents of each column and a comma foc separate
the columns.

the three formats (Fame, Osiris and Gesmes) are internal to
Eurostat.

25



Help

Help Menu

:;;gﬂJ@ > From the Information and Help menu, » (ALT, t, H)
choose Help

Note : you are in a file managed by MS-Windows.

Help Interface

File Edit Bookmark Help ®

i R S e
5 11188

CUBX for WIN | ontents

q Thas help i= divided in 4 parts

@ to @ . managed by Windows' Help program.

® Opens automatically the specific help files.

® 2 buttons: to go to the previous page.

to go to the next page.

@ Jump to a cross-reference : if you click any term or phrase in colour and/or
underlined, yeu go straight to the specific part of the help file.

® Menu Bar : managed by Windows' Help pregram.

26



This page is left intentionally blank for your notes...
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A memo on

Regular expressions (Unix)
Definition

A regular expression is a form used to specify and match strings. Regular
expressions use metacharacters (characters with a special meaning) and
nonmetacharacters (normal characters) as described below.

Introduction

The regular expression allows you to make sorme selections (to highlight them)
or to remeve existing selections (to remove the highlighting) in order to Select or
Unselect them.

Using regular expressions replaces a series of the actions with the mouse in the

dialog box before c¢licking fo effect the transfer between the

selection and unselection boxes :

1 Click the select buttan

2 In the "select - unselect positions" dialeg box that appears, you click
to highlight the item to select or unselect ; and you click to remove
this highlight.

3 The following dialog box appears : you enter a regular expression that will

alfow you to highlight {or ta remove) the existing items.

Enter a pattern (UHIX regular expression)

N.*

A regular expression is a formalised way of describing a pattern which is then
used to search {in this case) the labels with a view to select or unselect
autematically.

For example, the regular exprassions N.*" finds all the labeis beginning with a
capital N (N followed by zere or more character of any sort - ** meaning ‘any

singie character” and "** meaning the ".” occurring 0, 1, 2. times),

28



Regular expression Metacharacters

To build a regular expression, you will need some of the following
metacharacters. Here are all the metacharacters (MC} supported in CUB.X.

MC | Name Meaning MC | Name Meaning

\ back-slash | protection | { left begin of expression
parenthesis

A caret negatich ) right end of expression
parenthesis

[ left square | begin of * asterisk repeat 0,1,2,... times
bracket class the expression to its
left
1 right end of ? question mark | repeat 9 or 1time the
square class expression {o its teft
bracket
| pipe logical OR | + plus repeat 1,2,3... times
the expression to its
left
dot any single

character

Basic expression

A basic expression is one the following :

Nonmetacharacter
A if you write A, you will match the letter A

Quoted metacharacter

\* Matches one of the special metacharacters, in this case the
asterisk "™,
With "V, you cancel the effect of the metacharacter.

Character class
[ABC] Matches any one of the characters AB or C;

[A-20-9] Matches one letter from A to Z (only in uppercase) er a digit.

Complemented character class
[“0-9] Matches any character except a digit.
Note : the * (negaticn) is active throughout the class.
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Operators
These operators combine regular expressions into [onger ones :

Alternation A|B Matches A or B {uppercase)

{AB} | (CD) Matches ABorCD, butnotAorBorCorD

Concatenation ~ AB Matches uppercase A immediately followed by
' uppercase B

Closure A* Matches zero or more A's : {fZj CACAATALY
{nothing or one or many uppercase A's)

Positive closure A+ Matches one or more A's : {A; AA; A} (at least
one uppercase A)

Conditional closure A% Matches zero or one A's : {E; A} {nothing or

one A)

Parentheses {r) Matches the same strings as the expression 'r'
does ; used to group many expressions, and also
to give them pricrities.

Use the labels for selection

J@ ¥ From the Optiocns menu, ook at the command +/- Labels,

When you use a regular expression, you can do the selection on the entire label
or on the abbreviation (Belgium" or 'be" : in the selection boxes, you will
always have the abbreviations, so you must work with labels from memory, or
place the dialog box in a such way that you can see the labels from the
displayed table.

¥»  To scan the entire set of labels with a regular expression, there must

be a check mark (\/}.

For example : for the dimension ‘eeccountry’ you can write Belg.*"to select
Belgium, cnly if you use the entire label.

No check mark means that you use the abbreviation "b.*"
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PART i

Methodology

Introduction

The methodology begins with some introductory reflections on concepts and
practical difficulties the statistician must face when elaborating statistics on
SMEs. The following sections explain the major charactetistics of the SME
tabular database and the possible country deviations. The reader will find a
summary table at the end providing the basic information by country necessary
to interpret the results in this publication: main source, analytical unit, size and
sectoral coverage, availability of economic variables, exchange rate of the
national currency with the ecu.

Detailed information on the country methodologies necessary to analyse and
compare the data correctly is provided next. Although the structure of the data is
simple, it does not necessarily allow automatic processing, but often requires
the consideration of exceptions, due to data availability problems and differing
collection systems in the EU Member States.

Main elements of the SME tabular database, provided on the diskettes:

Geographical coverage The whole of each country
Anaiytical unit Enterprise
Sectoral classification MNACE 78, three digit level
Size class breakdown 0, 1-9, 10-19, 20-49, 50-29,
(number of employees) 100-199, 200-249, 250-489, 500 +
Economic variables Total employment

Salaried employment

Turhover

Value added

Labour costs
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A. General Methodology

1. Statistics on SMEs: relevant concepts and practical
difficulfies

The whole problem with policies for supporting small firms rests on the theory
that a small unit has cenrtain features which distinguish it from a large one and,
above all, that it has specific economic difficulties. The job of the statistician is
to put together a set of information which will give policy-makers clear
guidelines, while ensuring that the indicators are feasible, easy to interpret and
internationally comparable. Three basic questions, not always easy to answer
with the information currently available, have to be asked.

Defining a statistical unit

In most cases it is clear that policy-makers are interested in units with strategic
power, particularly over investment decisions. Statisticians find this elementary
decision-making unit in the enterprise concept set out in the European reguiation
on statistical units.

The definition of an enterprise requires a coherent economic entity to be
constructed from legal entities. This does not, however, guarantee international
comparability which is entirely adequate for analysis by size class. Deciding how
to aggregate legat entities is often a complicated matter.

In every Member State, the organization and size of businesses is influenced by
institutional conditions (taxation systems, social contributions, subsidies
availabie) but afso by the nature of the economic fabric and managerial culture
{in some countries it is standard practice to call in an external firm as a
subcontractor or provider of services; in other countries this is unknown). This
may affect the breakdown not only by size class, but also by sector of aclivity.

it is therefore useful when making comparisons between countries or over time
to have an idea of the effects of national legislative and economic contexts on
the structure of units.

The use of the '‘group of enterprises’ unit would make the figures more
comparable by systematically covering all units belonging to a group ahove a
specific participation percentage, and would also be better attuned to the
problems of SME policy-making, since belonging fo a powerful group brings
strategic opportunities not available to smal! independent firms, This unit is,
however, impossible to construct at present in most Member States of the
European Unicn.
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Choosing the criteria for breakdown by size class

Once the unit is selected, the criteria (employment, turnover, other financial
ratios, etc.} and the classes likely ta bring out the specific features sought in the
target population have to be chosen.

Recently, the Commission has adopted a communication harmonizing the
definitions in current use at the Union levell. This text gives thresholds based on
employment and turnover (or total assets) pius a criterion of not belonging to a

group.

At present, most available statistics do not enable all these criteria to be cross-
referenced; the most commonly-available breakdown is employment.

A single definition put forward for political or administrative reasons may seem
restrictive for in-depth analyses. The response of the statistician will be to give
analysts a measure of flexibility by suggesting narrower size classes, making it
possible to work on a larger number of sub-populations. Eurostat's tabuiar
database on SMEs is tending in this direction, thanks to the cross-referencing of
detailed breakdowns by size class and sector of activity.

How fo interpret trends

Interpretations of trends over time by size class may lead to misunderstandings.
An interpretation of the growth of economic variables corresponding to a given
size class should take into account the effect of firms entering and leaving the
size class, as well as the actual growth of firms remaining in it.

The difference between net entries and growih proper is extremely difficult to
calculate, since individual data have to be followed up over time. This is not
usuaily the case with the aggregated data available, which are based on cross-
sections of the population at a given moment. The best way of obtaining a
detailed analysis of the dynamics of certain categories of firms would be to
conduct longitudinal studies (linkage over time of individual data to firms). Such
approaches are increasingly common and very promising.

The possible scale of the effects of changes in size classes should be constantly
borne in mind when using aggregated data. Growth rates may be misleading:
the population in a class centaining very few individuals may easily be doubled
by the arrival of a single firm. Since data broken down into @ number of sub-
populations often include classes with small numbers, the small numbers effect
should be taken into account by calculating, for example, the contributions to
total change.

1 Commission Recommendation No 96/280/EC of 3 April 1996 concerning the definition
of small and medium-sized enterprises {text with EEA relevance).
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2. Main sources of the SME tabular database
For most of the countries, data have been preduced by public institutions.

These are primarity:

* the national statistical institutes: in many cases they integrate different
official data sources such as enterprise censuses, the VAT register, the
statistical business register, results of surveys, elc.;

* the social security autherity, which is a major source of empleyment data.

In some cases, data come from private institutions.

tn general, the SME tabular data are created from several sources, either at the
national level, or from Eurostat.

This is necessary when:

¢ one source cannot provide all the variables requested {example: the social
security authority generally cannot provide data on turnover or value
added),

* ane source does not cover all economic sectors (in several countries
surveys are carried out for some sectors as VAT registers do not contain
exempted sectors);

* one source cannot provide information on all enterprise sizes (example:
industrial censuses generally do not cover the smaller firms; social security
registers do not include enterprises without employees).



3. Classification of economic activities

Data on the diskette are broken down accerding to the NACE 70 nomenclature,
established by Eurostat in 1970. From 1993 onwards, data are classified by the
more recent NACE Rev. 1 nomenctature.

The NACE 70 divides economic activities info 10 broad divisicns (one digit
levels, for example '4' is 'Other manufacturing industries’) which are subdivided
further inte more detailed classes (two digit levels, e.g. ‘43" is ‘Textile industry’)
and further into groups (three digit levels, e.g. *433' is 'Silk industry’) and even
mote detailed sub-groups. The exhaustive list of ali NACE 70 divisions and
classes is given in an annex.

Most countries provide the data directly in the NACE 70 classification. However,
several countries have applied a different nomenclature, either a national one, or
the 1SIC {Internationat Standard Industrial Classification from the UN).

In these cases, Eurostat had to convert the data to the NACE 70 classification.

The more detailed the data provided by the countries, the greater the success of
the conversion procedure. However, in most cases, sectoral aggregations and
exceptions cannot be avoided.

Data cover all non-agricuttural market activities, a definition which mainly
excludes the following economic sectors:

+ agriculture, hunting, forestry and fishing (NACE 0);

* central banking authorities (NACE 811);

* public administration, national defence and compulsory social security,
{(NACE 91},

» other services provided to the general public, e.g. social work, trade unions,
tourist offices, etc. (NACE 96);

* domestic services (NACE 99);

* diplomatic representations, international organizations and allied armed
forces (NACE 00Q).

The separation of ;narket and non-market services, which affects mainly ‘other
services' {NACE 9), is not always possible in a satisfactory way, especially if
data are not provided in NACE 70 and have to be converted. Comparisons of
country resuits for this economic activity should therefore be carried out
cautiously, especially when a high level of disaggregation is applied.
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4. Units

The enterprise is the unit principally used in the national SME data, but several
countries cannat provide enterprise data and thus send data on lecal units, kind-
of-activity units or others. Most of the statistical units used are defined in the
Council Regulation (EEC) on the statistical units for the observation and
analysis of the production system in the Community.1

The enterprise

is the smallest combination of legat units that is an organizational unit producing
goods or services, which benefits from a certain degree of autonomy in decision-
making, especially for the allocation of its current resources. An enterprise
carries out one or more activities in one or more locations. An enterprise may be
a sole legal unit.

The local unit

is an enterprise or part thereof (e.g. a workshop, factory, warehouse, office,
mine or depot) situated in a geographically-identified place. At or from this place
ecanomic activity is carried out for which (save for certain exceptions) one or
more persons work (even only part-time) for one and the same enterprise.

The kind-of-activity unit (KAU)

groups all the parts of an enterprise contributing to the performance of an
activity at a detailed sectoral leve! (four digit level of NACE Rev. 1) and
corresponds to one or more operational subdivisions of the enterprise.

The local kind-of-activity unit (focal KAU}

is the part of a KAU which corresponds to a.local unit. Several countries send
data on establishments. The definition of an establishment comes closest to the
definition of a local KAU.

The enterprise group

is an association of enterprises bound together by legal and/cr financial links. A
group of enterprises can have more than one decision-making centre, especially
for policy or production, sales and profits. It may centralize certain aspects of
financial management and taxation. It constitutes an economic entity which is
empowered to make choices, particularly concerning the units which it
comprises.

The other units used by some Member States are legai units: the employer or
the VAT unit; they do not correspond directly fo one of the definitions above and
are defined in national administrative registers.

Due to such specific definitions, data for different statistical units are not fully
comparable. The size class breakdown should be read with caution as the
definition of a unit strongly influences its size.

1 Regutation {EEC) No 696/93 of 15 March 1993,
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5. Definition of the size classes

The main characteristic of the SME data is its breakdown by employment size
classes. The size class boundaries are expressed in terms of employees; this
allows us to separate sole proprietorships (size class zero) from the rest of the
enterprise population, as they employ by definition only non-salaried staff,
consisting of the entrepreneur and often family members or persons waorking
under a very small contract.

In accordance with Eurostat's data request, most countries send the natienal
data using the following detailed employment size classes:

. 0

. 1-9

. 10-19

. 20-49

. 50-99

. 100-199
. 200-249
. 250-499
. 500 +
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6. Economic variables

As well as the number of enterprises by size class, the SME data contain several
economic variables: '

employment: number of persons employed and number of employees;
total turnover;

value added at factor costs;

labour costs.

Employment

*  Number of persons employed {total employment)

The number of persens employed is defined as the total number of persons
who work in the enquiry unit (inclusive of working proprietors, partners
working regularly in the enterprise and unpaid family workers), as well as
persons who work outside the unit but belong to it and are paid by it {e.g.
commercial representatives, delivery men, repair and maintenance groups).
Included are persons absent for a short period (e.g. on sick leave, paid leave
or special leave), and also those on strike, but not those absent for an
indefinite period.

Also included are part-time workers who are regarded as such under the
laws of the country concerned and who are on the payroll, as well as
seasonal workers, apprentices and homeworkers on the payroll.

Excluded are labour forces made available to the unit by other enterprises
and charged for, persons carrying out repair and maintenance work in the
enquiry unit on behaif of other enterprises, as well as those doing their
compulsory mifitary service,

*  Number of employees (salaried employment)

Persons who work for an employer and who have a contract of employment
and receive compensation in the form of wages, salaries, fees, gratuities,
payments by result or payments in kind. Homeworkers, regardless of
whether they are on the payrol! or not, are excluded.

Monetary variables

Maonetary data such as turnover, value added and labour costs are provided by
the countries in the respective national currency.

All data published are converted into ecu by Eurostat using the yearly average
official exchange rate, Data are in current prices; no deflater has been applied.
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Turnover

The turnover is the totals invoiced by the unit during the reference period,
that is alt market sales of goods or services supplied to third parties.
Turnover includes all duties and taxes on the goods or services invoiced by
the unit with the exception of value added tax (VAT) invoiced by the unit vis-
a-vis its customers. It includes all other charges (transport, packaging, etc.)
ascribed to the customer even if these charges are listed separately in the
invoice. Reduction in prices, rebates and discounts, as well as the value of
returned packaging must be deducted, but not cash discounts.

Turnover does not include sales of fixed assets. Operating subsidies
received from public authorities or the EU are also excluded.

In the banking sector, turnover is defined as interest and commission
received. In the insurance sector it corresponds to gross premiums written
and pension contributions.

Value added at factor costs

Value added is a measure of output used to assess the wealth generation by
an enterprise through its transformation of bought-in goods and services into
marketable goods and services. it is measured in the following way.

Value added at factor cost =

production value

- intermediate consumption

- consumption taxes invoiced by the enterprise to its customers
- other indirect taxes

+ operating subsidies,

Production value =

total turnover

- cost of products for resale (excluding deductible VAT)

+ change in stocks of finished and half-finished products

+ change in stocks of goods for resale

+ value of investment goods manufactured or constructed by own
personnel for own use,

Intermediate consumption =

purchases of raw materials, intermediate goods, etc. (excluding deductible

VAT)

+ cost of industrial services received (excluding deductible VAT)

- changes in stocks or raw and ancillary materials, intermediate goods and
energy (excluding deductible VAT)

+  cost of non-industrial services received (excluding deductible VAT).
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* | abour costs

They measure the expenditure borne by employers in order to employ workers.
They can be subdivided into direct and indirect costs.

Direct labour costs

- direct remuneration (including bonuses and gratuities paid regularly);
- ather bonuses and gratuities;

- payments for days not worked;

- payments in Kind.

Indirect labour cost_s

- statutory social security contributions and family allowances paid by the
employer;

- non-statutery payments made by employers under agreement or contracts or
voluntarily;

- vocational training costs;

- aother social expenditure.
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7. Treatment of confidential data

Due to confidentiality, most countries do not allow the disclosure of data
concerning a very small number of enterprises, usually two or three units. As in
the SME tabular data the enterprise population is broken down by two
dimensions, size and economic sector, there are, especially in the smaller
countries, quite a lot of cells which have to be hidden,

Countries apply their own rules for confidentiality treatment. Some of them do
not consider any data as confidential, for most of them confidentiality only
applies to the economic variables, and there are exceptions where even the
number of units has to be treated as confidential.

Two different methods of confidentiality treatment are applied.

* Some countries hide confidential data at the national level and do not
provide such data to Eurostat,

* The majority of the countries, on the other hand, provide confidential data
which has to be hidden by Eurostat. This allows a better harmonization of
resuits because the same aggregates can be caiculated for each country.
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8. Estimations

For the purpose of having data for the whole of the ElJ, Eurostat has carried out
a set of estimations by country. These estimations were necessary because the
originai data sets provided by the Member States were not always complete or
fully harmonized.

The estimated data sets for EUR 12 {1990} and EUR 15 (1992) contain three
variables which are broken down by the detailed size classes and by NACE 70,
two digit level:

* number of enterprises
* total employment
* turnover.

Depending on the country, the following main estimation steps were necessary:

» gstimation of missing ecohomic sectors

* estimation of a missing variable

= estimation of a missing size class (especially the class with no salaried
employment)

= splitting aggregated sectors

= splitting aggregated size classes

* harmonization of the statistical units.

The user should bear in mind that estimaticns have been made by simple
methads using national accounts data to fill in the major gaps.

The figures for EUR 15 are not necessarily equivalent to the sum of the country
raw data published here, Compared to the EUR 12 estimations for 1990,
estimation procedures for EUR 15 have changed considerably, and comparisons
on a disaggregated level should therefore be aveided.
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9. Data comparability
Comparability between years

Countries sometimes change their method of data collection: a new source may
be added, the underlying register may be improved, the analytical unit may
change, or results of a periodic census may be available one year but not the
next one. Such factors severely reduce comparability.

Comparabifity with other sources

To compile the SME tabular data, countries generally use or combine sources.
These may be different from the sources used for the national accounts data.

The SME data cover all non-agricultural market activities which means that an
important part of the economy and of employment is excluded.

Differences in the underlying sources and in the sectoral coverage lead to
diverging values when comparing the SME data with other statistical sources.
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B. Methodology by Country

Belgium - LN.S.

Sources

The Institut Nationat de Statistique (INS) provided data using the VAT register.
The VAT register covers all units liable for value added tax. Statistics are
preduced monthly, quarterly and annually.

Reference year(s)

1982,

Reference unit

The VAT-declaring unit: all units regularly engaged in activities providing goods
or services that are subject to VAT payment. All units active for any part of the
year are included.

No threshold for VAT payment in terms of minimum turnover exists. However,
some VAT units can be exonerated from periodical VAT staterments:

* small retailers in food, footwear, clothing, books, newspapers, etc. when
their purchases do not exceed BFR 4.5 million (food sector) and BFR 2.5
million (the others), they can pay instead what is cailled the ‘taxe
d'égalisation’,

*  some other sectors can also skip VAT payment: farmers, second-hand
deaiers, waste coliectors, artists, etc.
Only the first category has a relevant turnover.

This reference unit has an important overlap with the employer which is the
reference unit used by Organisation Nationale de la Sécurité Sociale (ONSS).
All employers who are included in the Social Security Register, being active in
any of the sectors liable for VAT, are also counted as a VAT-declaring unit.

Size class 0

Size class 0 is included in the VAT register. The coverage is not 100% because
some smalt units are exempt from periodical VAT statements.

For 19982, a descriptive register (‘fichier signalétique’} with alt the units liable for
VAT payment (but not necessarily actually paying) was used to count the
number of units in size class 0.
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Variables

1. Number of units: the number of VAT units.

2 a. Total employment: only for size class zero.

2 b, Salaried employment: not available. See; Belgium - O.N.S.8.
3. Turnover: as declared to the VAT register.

4.  Value added: not available.

5.  Labour costs: not available.

Classification

Economic sector: the nomenclature used is the VAT-NACE, which corresponds
at three digits exactly to NACE 70. The main activity is determined by the largest
turnover.

Sectoral coverage: some sectors which are not liable to VAT payment are
missing.

* cerfain services such as notaries, lawyers, hospitals, resting houses,
medical services and some paramedical services;

* social and cultural institutions such as libraries, museums, education
centres,

* some banking and financial activities, certain counselling activities;

*  public administration.

Employment size class: expressed in terms of salaried employment.

Size classes 6 (200 to 249 employees) and 7 (250 to 499 employees) are joined

together in one size class (200 to 499 employees).

Monetary unit
Data supplied in Belgian francs (BFR}, the exchange rate being:

ECU 1 = BFR 41,5932 (1992).

Confidentiality

Data considered confidential by INS have been treated by Eurostat in
accordance with INS specifications to prevent disclosure (three or fewer units).
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Belgium - O.N.S.S.

Sources

The Organisation Naticnale de la Sécurité Sociale (ONSS) provided data based
on their own registration of employers. Employers’ declarations were used to
compese annuat statistics. Every employer with one or more employees is
obliged to contribute to the social security system and is consequently
represented in the register.

Referenice year(s)

1990, 1991 and 1992,

Refarence unit

The employer. every employer who engaged one or mere werkers in the second
trimester, who were fully or partially submitted to the social security system, is
included.

This reference unit has an important overlap with the VAT-declaring unit of the
Belgian Institut National de Statistique (INS). All employers included in the
Sacial Security Register, active in any of the sectors liable for VAT are also
counted as VAT-declaring units. All sectors are covered in the Social Security
Register, but public administration was excluded for this exercise.

Size class 0

Not available.

Variables

1. Number of units: the number of emplioyers.
2 a. Total employment: not available, See: Belgium - |LN.S.

2 b. Salaried empioyment: number of full and part-time employees in the Sacial
Security Register at the end of the second trimester. Workers with mere
than one job working for different employers are counted mere than once.

3.  Turnover: not available,
4. Value added: not available.

5. Labour costs; data only available for 1992. Data supplied in millions of
Belgian francs and converted into thousands of ecu.
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Classification
Economic sector: all sectors from NACE 70 divisions 1 to 9 are included.

A firm's main activity is determined primarily on the basis of turnover. if these
figures were not available, the number of workers engaged in a certain activity
was taken.

Sectoral coverage: all employers regardless of the legat status. Data available
for both private and public sectors, that are kept separately.

Employment size class: expressed in terms of salaried empioyment.

Monetary unit

Data supplied in Belgian francs {(BFR), the exchange rates being:
ECU 1 = BFR 42.4252 {1990)
ECU 1 = BFR 42.2232 (1991)
ECU 1 = BFR 41.5932 {1992).

Confidentiality

No data were considered confidential, all data are published.
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Denmark

Sources

Danmarks Statistik provided data, the result of a special ad hoc exercise,
integrating four official sources.

1. The Business Register; based on two units — legal and local — using the
Directorate of Tax and Customs registers.

2. The VAT Register. based on the {egal administrative VAT unit. This accounts
far all units in all sectors except those exempt from VAT payment — personal
transport, banking, insurance and financial services, doctars and dentists
and education. The threshold for registration is ECU 15 000.

3. The register-based husiness employment statistics: using the employer's
annual salary declarations submitted to the Tax Directorate. From 1980
onwards, this source was supplemented with informaticn concerning the self-
employed.

4. The register-based account statistics: these aim for an automatic procedure
to select those enterprises whose tax declarations require special attention.
The reporting unit is the legal, taxable enterprise. The register represents
approximately 50% of total turnover realized by all Danish enterprises.

Reference year(s)

1990, 1981 and 1992,

Reference unit

The legal unit. a unit close, though not identical, to the enterprise, which
resulted from combining the four sources above. It comprises all units existing at
the end of November of the reference year with a turnover threshold of ECU
15 000 per year. All market sectors liable to VAT are included — industry,
construction, services. However, in order to preduce a comptetely compatible set
for the five variables, some sectors were excluded from the tables before
transmission to Eurostat.

Size class 0

This represents active legal units without employees and an annual turnover of
at least ECU 15 000,
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Variables
1. Number of units: number of legal units.

2a. Tofal employment: number of persons employed, both full and part-time
and the self-employed, at the end of November of the reference year.

2 b. Salaried employment: not available.
3. Turnover: does not cover activities which are not liable for VAT payment,

4. Value added at factor cost: The Danish definition of value added at factor
costs is slightly different from that of Eurostat. Some items are under-
estimated, others are overestimated, the differences are thus compensated
resuiting in negligible overall differences,

5 Labour cosis.

Classification

Economic sector: the main activity is the ane with the largest turnover and is
expressed in NACE 70 divisions 1-9 at the three digit level,

Employment size class: expressed in terms of salaried persons (full-time
equivalent) at the end of November of the reference year.
Moanetary unit

Data supplied in Dapish kroner {DKR), the exchange rates being:
ECU 1 = DKR 7.85645 (19580}
ECU 1 = DKR 7.90852 (1991)
ECU 1 = DKR 7.80925 (1892).

Confidentiality

Data considered confidential were eliminated by Danmarks Statistik before
transmission to Eurostat.

Remark

Since employment figures are expressed in terms of persons employed {(heads),

while intervals of employment size classes are in terms of full-time employees,
there are cases in which average employment exceeds the limits of the interval.
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Sources

The Institut fir Mittelstandsforschung (IFM), Bonn, provided data based on the
following official sources, submitted to extensive estimates:

1. For the number of enterprises.

s VAT Statistics 1990 and 1992 (Federal Statistical Office).
* Census of workplaces 1987 (Federal Statistical Office);
*  Statistics of the Social Security 1992 (Federal Labour Office),

*  Exception; for NACE 37 and NACE 5 the Statistics of the Manufacturing
Industries has been partly used.

2. For persons employed.

*  Census of workplaces 1987 {Federal Statistical Office),
®  Statistics of the Social Security {Federal Labour Office});

* Exception: for NACE 37 and NACE 5 there has been used partly the
Statistics of the Manufacturing Industries.

3. For the value added and turnover.

* VAT Statistics 1990 and 1992 (Federal Statistical Office)

Al tables (i.e. enterprises, employment, turnover and value added) refer to the
same popuiation.

Reference year(s)

1982.

Reference unit

The enterprise: the smallest unit that has to keep books for commercial and/or
tax law reasons and has a commercial/profit orientation.
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Size class 0

It represents the self-employed, that is units staffed only by self-employed and
non-salaried persons. Size class 0 is estimated for the year 1992, The number
of enterprises in this size class is estimated on the basis of the number of
enterprises in 1987 with a turnaver below DM 20 000 per year.

Variables

1. Number of units: number of enterprises.

2a. Total employment: salaried and non-salaried, fulltime and part-time
employed persons. In a partnership the owner is included. In a corporation
the owner is included only if employed officially.
The reference date is 30th June 1992,

2 b. Salaried employment: not available.
3. Turmnover: enterprises with a turnover below DM 25 000 are excluded.
4. Value added: enterprises with a turnover below DM 25 000 are excluded.

5. Labour costs: not available,

Classification

Economic sector: the firm's activity with the highest value in the tax
declaration. It is expressed in NACE 70 divisions 1-9 at the two digit level.

Sectoral coverage: alt non-agricultural market sectors are covered except the
following NACE codes: NACE 15 {nuclear fuels industry), 71 (railways), 79
{communications), 95 (medical and other health services; veterinary services).

Employment size class: expressed in the total number of employees.

Size classes 6 (200-249) and 7 {250-499) are joined together in one size class:
200-499.

Monetary unit

Data supplied in thousands of Deutschmark {DM), the exchange rate being:

ECU 1 = DM 2.02031 (1992).

Confidentiality

MNo data were considered as confidential.

Territorial coverage

West Germany and West Berlin before reunification.
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Greece

Sources

The National Statistical Service of Greece (NSSG) provided data using the
results of the Annual Survey of Industry. The sampled popuiation comes from
the Census of Enterprises and Establishments, and the sample is renewed every
five years, the latest update being in 1989.

The annual survey is based on a sample of units employing 10 to 12 persons
per year and is exhaustive for units with an average annual employment of 20
persons or more. Units with less than 10 employees are not included.

Reference year(s)

1982.

Reference unit

The establishment: unit in which one or more persons are engaged perm-
anently, under single management controf, or in one of the following —
extraction, preduction, repair, assembly, sale of goods or any auxiliary activity.

NB: The activity of such a unit is relatively homegeneous and therefore closer
to a Local Kind-of-Activity Unit (LKAU} than i a local unit.

Size class 0

Not available. Data were only provided for units with at least 10 employees.

Variables

1. Number of units: annual average number of establishments.
2 a. Total employment: average number of persons employed per year.

2 b. Salaried employment: average number of salaried persons empioyed per
year.

3. Turnover: annual totai based on the accountancy year, which coincides
with the calendar year or, if not, ends in the reference year. Taxes, such as
caonsumption tax and stamp duty, are excluded.

4. Value added at facter cost: annual total of value added (accountancy year:
see turnover).

5. Labour costs: not available.
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Classification

Economic sector: data have been provided in the NACE 70 nomenclature up to
the three digit level. A firm's most important activity is determined by a
combination of employment, turnover and profit figures.

Sectoral coverage: NACE sectors 1 to 4 and 67 up to the three digit level.
Canstruction and services are therefore not covered.

Employment size class: based on salaried employment, excluding units with
less than 10 employees, is formed as follows:

10-18, 20-49, 50-99, 100-199, 200-249, 250-499, 500 +.

The average number of persons employed (salaried plus non-salaried)
determines to which size class an establishment belongs. A unit is assigned to a
size class at the time of the five-yearly census and, regardless of changes in its
average emplioyment, remains in that size class until the next census (see:
Remark).

Monetary unit

Data supplied in drachmas (DR) and converted into ECU, the exchange rates
being:

ECU1=DR 201.412 (1990)
ECU 1 =DR 225.215 (1991)
ECU 1 =DR 247.026 ({1992),

Confidentiality

Canfidential data — regarding the data broken down by size classes -
transmitted by NSSG, have been treated by Eurcstat to prevent their disclosure
in this publication.

Remark

The sampling basis is updated once every five years (latest 1989),

Establishments are allocated to a certain employment size class and remain in it
for five years until the next updating during a new census round. An annual
survey does not take into account potential shifts of an estahlishment between
strata. New establishments and those that have ceased all activity are integrated
in the survey, based on an administrative register.
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Sources

The instituto Nacicnal de Estadistica (INE) provided the data, using two sources:

1. 'Directoric Centrat de empresas de! INE' {(DIRCE). a central register of
enterprises based on administrative sources. This covers ail the non-
agricultural sectors {except public administration, health and education).

The sources for updating DIRCE are:

*  tax on economic activity {Impuesto sobre Actividades Econdmicas);
* the '‘Retenedores a Cuenta’ {another fiscal source),

*  the Social Security Register {Cuentas de Cétisation de Seguridad Social).

2. Census cf Local Units (1980). This covers all locat units (and enterprises as
a derived unit) engaged in activities carried out in buildings. It is expressed in
NACE Rev. 1 and covers the whole country.

Reference year(s}

1990 and 1991,

Reference unit

The enterprise; all existing enterprises on 31st December of the reference year,
including those recently created.

Size class 0

This represents all enterprises which are active but without empioyees engaged
in the Social Security Register. !t is thought that this class may be somewhat
overestimated in terms of both numbers and employment because of difficulties
and delays in detecting ‘deaths’ or transitional periods of inactivity.
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Variables

1. Number of units: number of enterprises.
2 a. Salaried employment.
2 b. Total employment.
Data refer to 31st December of the reference year.
3. Turnover: not avaitable.
4, Value added. not available.

5. Labour costs: not available,

Classification

Economic sector: data were supplied in the ‘Clasification Nacional de
Actividades Econdmicas' (CNAE) at three digits, with three exceptions at two
digits (CNAE 71, 73, 81). A conversion to NACE 70 covering NACE divisions 1-9
was carried out by Eurostat resulting in a classification at three digits and in
some cases at two digits.

Enterprises active in more than one sector were classed according to the activity
with the highest number of employees.

Sectoral coverage: all non-agricuitural secters are included, with the exception of
official post offices, libraries, public activities and museums, sports facilities,
health and veterinary services.

Employment size class: intervals are expressed by the total number of
employees.

Monetary unit

Ne monetary variables have been provided.

Confidentiality

No data were considered as confidential.

Territorial coverage

The Peninsular territory, the Islands and Ceuta and Melilla.

Remark

Due to the conversion from the CNAE nomenclature to NACE, some NACE
codes had to be aggregated.
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France

Sources

The Institut Naticnal de la Statistiqgue et des Etudes Economiques (INSEE)
provided the data. They were extracted from two sources, the Unified System of

Business Statistics (SUSE) and the Coordinated Survey of Small Enterprises
(ECPE).

1. The '‘Systéme Unifié de Statistiques d'Entreprises’ is composed of:

a. The Fiscal Registers.

- Bénéfices Non Commerciaux {(BNC): non-trade profits, such as those
in the professions, health sector, etc.

- Bénéfices Industriels et Commerciaux (BIC): industrial and trade
profits.

These can be divided into three types:

(i) the normal cne (enterprises with three or more employees);

(i) the simplified one (fewer than three);

(i} the ‘forfait’ (enterprises below an annual turnover of FF 700 000, i.e.
mainly independent crafts).

b. Annual Survey of Enterprises. It is exhaustive for enterprises employing
2 minimum of 20 persons and is based on samples for the smaller
enterprises. It is also used to control and complete the fiscal sources.

2. The ‘Enquéte Coordonnée des Petites Entreprises’ (ECPE) was used to
estimate total empleyment an the base of salaried employment. This survey
is carried out every five years — the latest one was in 1988, with more recent
information therefore not being available yet.

Reference year{s)

1690, 1991 and 1892,

Reference unit

The enterprise: all enterprises that have existed for at least six months are

registered regardiess of their legal form or employment. All sectors are included
except certain non-profit making activities.

Size class 0

This represents enterprises with only non-salaried employment and enterprises
with a turnover below FF 500 000 regardiess of the number of employees.
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Variables

1. MNumber of units: number of enterprises.
2 a. Total employment: only availabie for 1990,

2b. Salaried employment: full and part-ime salaried employment on 31st
December of the reference year.

3. Turnover: as defined within the ESAI {(Enquéte Structurelle sur 'Activité de
I'Industrie), expressed in millions of francs.

4. Velue added. as defined within the ESAIl. Changes in stock are not
considered for very smalt units (régime forfait).

5. Labour costs! only avaitable for 1992,

Classification

Economic sector: expressed in NACE 70 divisions 1-9 at the three digit level. A
firm's sector is determined by the activity with the largest share of employment
and, in services, the one with the largest share of turnover.

Employment size class: expressed in terms of salaried employment.

Monetary unit

Data were supplied in French franes (FF), the exchange rates being:

ECU 1 =FF 6.91416 (1990)

ECU 1 =FF 6.97334 (1991}

ECU 1 = FF 6.84839 (1982).

Comparability

It is not possible to compare absolute numbers or totals for any of the four
variables for size classes 0 and 1-9, only ratios. For size classes 10 + absolute
numbers may be compared cautiously.

Confidentiality

Canfidential data were transmitted by INSEE and treated by Eurocstat.

Territorial coverage

Metropelitan France and averseas territories.
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Italy

Sources
The Istifute Nazicnale di Statistica (ISTAT) provided the data. They are deduced

from the Census for Industry, Trade, Transport and Services (1991) from which
the results are now availabie.

Reference year(s)

1991,

Reference unit

The enterprise.

Size class 0

Size class 0 (self-employed) is not registered as a separate size class but mostly
included in class 1-9.

Variables

Number of units: the number of enterprises existing on 21st October 1991
Totat employment. total number of employees on 21st October 1891
Salaried employment: salaried employment on 21st October 1991,
Turnover: not available,

Value added: not available.
Labour costs: not avaitable.

DAL~
)

Classification

Economic sector: Data have been provided in NACE Rev. 1 classification up to
the four digit level. Data have been converted to NACE 70. Where there is more
than ane activity, the main one is based on the largest share of turnover.

Employment size class: size classes are in terms of total persons employed.
The size classes are as follows:

1-9,10-19, 20 - 89, 100 - 199, 200 - 249, 250 - 499, 500 +.

Monetary unit

Data supplied in Italian lire (LIT), the exchange rate being:
ECU 1 = LIT 1533.23 (1991).

Confidentiality

The data provided had no confidentiality constraints.



Luxembourg

Sources

The Service Central de la Statistique et des Etudes Economiques (STATEC)
provided the data, compiled from two sources.

1. The Sccial Security Register.
2. The VAT register.

Reference year(s)

1992.

Reference unijt

The enterprise: al! units are registered bearing the same identification number
and activity code.

All enterprises active in the reference year are considered. New enterprises are
included as long as they declare some turnover during the year. There is an
optianal threshold of LFR 400 000 (from 1990) on the VAT Register: however,
even below this threshold, most companies choose to register.

Size class 0

All active enterprises which in October of the reference year do not count with
any employee in the Social Security Register. Due to some delays in the
accounting of the cessations, this size class might be somewhat inflated.

Variables

1. Number of units: number of enterprises.
2 a. Total empioyment: not available

2 b. Salaried employment: number of salaried employees.
The reference date is 30th October 1992,

3. Turnover: total sales excluding VAT. Data are supplied in millions of [LUF.
4. Value added: not available.

5. Labour costs: not available.
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Luxembourg (continued)

Classification

Economic sector: NACE 70, divisions 1-9 at three digits. Firms active in
several sectors are assigned to the one generating the [argest value added,

Employment size class: expressed in terms of salaried employment.
The size classes are:

0 (for the units), 1-9, 10-19, 20-99, 100-189, 200-4829, 500 +.

Monetary unit
Data provided in Luxembourgish franes, the exchange rate being:

ECU 1 = LFR 41.5932 (1992).

Confidentiality

The number of enterprises and the number of employees are not confidential.
Turnover is confidential if it applies to less than four enterprises or if one
enterprise accounts for more than 75% of the total turnover. The treatment has
been done by Eurostat.
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The Netherlands

Sources

The Centraal Bureau voor de Statistiek (CBS) provided the data, mainly frem an
annual multi-sectoral structural survey whose population and sampling frame is
provided by the Central Business Register.

The sectors which are distinguished are the manufacturing industry, public
utilities, construction, transport and other services. The activity is expressed in
the national nomenclature — SBI — at the three digit level for all sectors
{conversion to NACE was carried out subsequently), both for integral and
sample statistics. With the exception of manufacturing, sample statistics are
sometimes expressed in two digits rather than three.

Reference year(s)

1991 and 1992,

Reference unit

This is the Kind-of-Activity Unit. It car be an enterprise, part of an enterprise
or a combination of different enterprises which predominantly engages in one
kind of econemic activity, and is not restricted to a geographical area. The KAU
ceincides in the majority of the cases with the enterprise.

Reference populaticn: the KAUs, including takeovers and newly-created
enterprises, that receive the annual enquiry form. In Nevember of the reference
year they must have been part of the monthly observation of that year or
abserved before that date,

Thresholds: industry and construction — a minimum of one employee. The wheie
economy — at least one person regularly working a minimum of 15 hours per
week (i.e. approximately half a man-year),

Size class 0

This size class is registered for the service sector. The unit is included if it is
active for at least 15 hours per week on a regular basis. There is no size class 0
for industry and construction,

Three sources were used for demographic data on size class 0: the Business
Register, the Survey on Services and the Annual Census of Firms.
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The Netherlands (continued)

Variables _

1. The number of units: the number of Kind-of-Activity Units.

2a. Total employment: includes all full-time, part-time and temporary
employees as well as working proprietors, family workers, managers,
shareholders, etc.

2 b. Salaried empioyment: it includes wage-earners werking 15 or more hours
per week and insured under the 'Sickness insurance Act, homeworkers

" under the same insurance and wage and salary earners aged 65 and over.

3. Turnover:

- Industry and construction:
sector's turnover = industrial sales + trade activities + other activities

- Services:
turnover = total revenues (excluding : interest yield, operating subsidies,
reduction of provisions, VAT, value of own production and exceptional
receipts)

4. Value added:
gross value added = production value - intermediary consumption.

5.  Labour costs: the total cost of employees.

Classification

Economic sector: data were provided in NACE 70 divisions 1-8 at the three
digit level. The main activity was assigned on the basis of the highest value
added. For industry, construction and transport, in practice, it comes to an
assignment by the largest number of employees.

Sectoral coverage.

Industry and construction: all sectors are covered, whether public or private,
and regardless of legal status.

Services: only private sectors are included. In NACE 70, the following are
excluded: 63, 643, 663, 666, 672-5, 81, 82, 831-4, 850, 91, 93, 94, 95, 96,
97 (but 972 is included), 883, 984, 99.
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Employment size class: For indusiry and construction: number of paid man-
days per year regisfered by the professional federations. These data are
converted into man-years. For the transport sector: the size is based on the
number of paid employees at the end of the year. Other services: average size.

The size classes are:

0, 1-2, 0-4, 5-9, 10-19, 20-49, 50-99, 100-199, 200-499, 500 +.

Monetary unit

Data supplied in Dutch guilders (HFL), the exchange rates being:

ECU 1 = HFL 2.31093 (1991)

ECU 1 = HFL 2.27482 (1992).

Confidentiality

In some cases, size classes were aggregated by the CBS in order to maintain
confidentiality. This results in non-harmonized size classes. NACE classifi-
cations at the three digit level were sometimes aggregated to the one and two
digit level for confidentiality reasons.

Remark

1. Size coverage differs between industry/construction and services;
industry/censtruction cover enterprises with at least one employee, services
also include size class 0. Due to some methodological differences in the
collection of data, care should be taken when comparing the different
sectors.

2. The employment registration differs between industry — pant of construction
and the remaining part of construction — (salaried employment) and services
{total employment}.

3. Reference date; the total is at the end of September for all sectors except for
the transport sector where the total is at the end of the year.
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Austria

Sources

The Osterreichisches Statistisches Zentralamt provided the SME data
compiled from the 1981 and 1892 annual industrial surveys.

In Austria, establishments carrying out economic activities defined by ISIC
Rev. 3 codes 10 to 45 are differentiated by their classification into the
sections ‘industrie’ and ‘Gewerbe’ of the Federal Chamber of Commerce.
The section 'Gewerbe' itself is divided into 'Groigewerbe' (20 employees or
more} and 'Klein- und Dienstleistungsgewerbe’ (0 to 19 employees).

The data collection is exhaustive for all establishments beionging to the
section ‘Industrie’ of the Austrian Federal Economic Chamber and for the
establishments with 20 of more employees in the 'Gewerbe' section.
Establishments in the ‘Klein- und Dienstleistungsgewerbe' class (less than
20 employees) are surveyed by sampling.

Reference year(s)
1991 and 1992

Reference unit

The establishment: a local self-contained unit capable of reporting
production costs. No inclusion thresholds er limitations regarding certain
legal forms exists.

Sizeclass 0

The size class 0 is included: establishments with no salaried employment
belonging to the 'Industrie’ section. Enterprises without salaried employ-
ment belonging to the ‘Gewerbe’ section are not included.

Variables
1. Number of units: the number of establishments.

2 a. Total employment: salaried and unsalaried employment (seif-
employed, family workers), both full and patt-time.

2 b. Salaried employment: wage and salary earners, bath full and
part-time.

3. Turnover: total sales.

4.  Gross value added: gross production value minus intermediate
consumption.

5. Labour costs: all costs related to the salaried employment, that is
wages and salaries, contributions of the employer o social security,
and other related costs.
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Classification

Economic sector: expressed in ISIC Rey. 3 at the three digit level. The
ISIC codes are the result of a reclassification according to the Austrian
‘Betriecbssystematik 1968'; this reclassification has been done by the
Austrian Central Statistical Office. The conversion to NACE 70 has been
done by Eurostat. The main activity is determined by the activity which
accounts for the largest part of net production vatue,

Sectoral coverage. the manufacturing industry and construction sectors,
from 1SIC Rev. 3, codes 10 to 45, No services are included.

{See also; Saurces),

Employment size classes: expressed in terms of number of salaried
employees.

A commoen size class breakdown for both the exhaustive and the sampled
data is not possible {see Sources). Data for 1991 and 1992 therefare
include only the results of the exhaustive survey, so size classes 0, 1-9 and
10-18 are not complete.

Monetary unit

Economic variables are expressed in thousands of Austrian schillings (O8),
the exchange rates being:

ECU 1 = OS 14.4309 (1991)

ECU 1= 08 14.2169 (1992).

Confidentiality

Data considered confidential (i.e. information on four establishments or less)
have been eliminated from the set of data transmitted to Eurostat.
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Sources

The Instituto Nacional de Estatistica (INE) provided data compited from the
Register of Statistical Units (FUE). This is updated from several sources.

1. The INE Annual Survey on Enterprises.

2. Employment tables from the Employment Ministry. These only cover the
medium-sized and large enterprises with at least 100 employees. The rest
are only partially covered.

3. The National Register of Enterprises from the Ministry of Justice. All new
units have to register to start an activity.

4. The Tax Register on Business Income from the Finance Ministry.
5. A special survey for updating the FUE.
8. The Register of Company Accounts.

Reference year(s)

1991 and 1992.
Reference unit

The enterprise: active for at least one year. The reference date is 31st
December of the reference year.

Size class 0

Most units in this group are enterprises without employees {i.e. a real class 0).
Enterprises for which there is no employment information are aiso included.
However, this number is negligible.

Variables
1. Number of units: number of enterprises active for at least one year.

2 a. Total employment. the number of (full and part-time) active persons
expressed in number of heads. The national accounts registers employ-
ment in full-time equivalents, thus resulting in a lower employment figure.

2 b Salaried employment: the number of salaried employees.

3. Turnover.

4. Value added at market prices.

5.  Labour costs.
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Classification

Economic sector: is expressed in NACE 70 at the three digit level. Firms with
more activities are classified according to the largest share of turnover.

Sectoraf coverage: industry, construction and services, NACE 1-9.

Employment size class: expressed in terms of salaried employment.

Monetary unit

Data supplied in ECU according to the following exchange rates;
ECU 1 = ESC 181.107 (1950)

ECU 1 =ESC 178.614 (1981)

ECU 1 = ESC 174.614 (1992).

Confidentiality

Confidential data have been treated by Eurcstat according to INE criteria {data
relating to one or two units).

Remark

For the four years before 1992 the number of enterprises has been estimated
using the 1892 data. This was hampered by insufficient information on
cessations from 1988-92. Consequently, having only information on active and
created enterprises, the total number of enterprises in the past is under-
estimated.

Territorial coverage

Continental Portugal plus autonomous regions.
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Finland

Sources

Statistics Fintand provided data from the Enterprise and Establishment Register,
which is based on the tax authorities database.

All new businesses receive an enquiry form from the Enterprise and
Establishment Register. At the start or closure of activities, enterprises must be
registered with the tax authorities either as an employer or as a personal
enterprise liable for turnover tax. This updating is carried out quarterly.

The business register is updated by guarterly enquiries into ail new enterprises,
annual enquiries into all enterprises with two or more establishments and
additional enquiries into all enterprises which have become active in new
localities.

Reference year(s)

1992,

Reference unit

This is the enterprise, whether made up of single units or physical persons. The

register contains information on all enterprises with paid employees, plus
corporate bodies and self-employed peopte liable to turnover taxes.

Enterprises have to fulfil two criteria. They must be active for at least six months
in the reference year and either:

* employ at least 0.5 persons in the reference year {ie. the fulltime
equivalent of half a year), or

* have a turnover in the reference year 1892 of at least MKF 46 000
{approximately ECU 9 000).

Size class 0

This represents enterorises liable to turnover taxes with {ess than 0.5 full-time
employees. The coverage is restricted by the following conditions:

*  aturnover above MXF 46 00D (1982),

* the sector/the enterprise should be liable to turnover tax payments.

NB: the positive labour costs for size class 0 is due to the definition of this
class: between zero and 0.5 full-time employment equivalents. This is the
same for salaried employment.
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Variables
1. Number of units: number of enterprises.

Z2a. Total employment. persons employed, both full and part-time, converted
into man-years,

2b. Salaried employment. the number of salaried persons, bath full-time and
part-time, converted into man-years.

3. Turnover. as reported in the business financial statement. For NACE 81,
82 and 83 turnover is not available.

4, Value added: not avaitable.

5. Labour costs: wages and salaries for salaried employment.

Classification

Economic sector: following the Standard Industrial Classification 1988 (SIC
Finland) at the three digit level. The conversion into NACE 70 divisions 1 to 9
has been carried out by Eurostat. Where there is more than one activity, the cne
with highest share of value added fs included.

Sectoral coverage: the sectors which are exciuded are extraction of petroleum
and natural gas (NACE 13), letting of real estate by the owner (NACE 15).

Employment size class: in terms of number of salaried persons.

Monetary unit
Data were given in Finnish marks (MKF), the exchange rate being:

ECU 1 = MKF 5.80703 (1892).

Confidentiality

Confidential data have been hidden by Eurostat, monetary variables on less
than three enterprises are considered confidential.
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Sources

Statistics Sweden provided the data based on the Financial Accounts Survey
(EFA), compiled frem the financial accounts of enterprises. The sampling frame
of EFA is the Central Register of Enterprises and Establishments (CFAR), which
is updated every fortnight.

The enquiry is exhaustive for enterprises with at least 50 employees. Data for
size class 0-49 are either collected exhaustively or sampled from external
sources, namely the National Board of Patents and Registration of Trademarks
(PRV).

For the extraction of the variables, two different sources are used:
*  for the number of enterprises and the number of employees: the business
register;

*  for turnover, valﬁe added and labour costs: the VAT register.
Reference year(s)

1992,

Reference unit

The enterprise: the legat or balance sheet unit, i.e. the smallest unit for which
most balance sheets and profit and loss data can be obtained. The threshold for
turnover is SKR 100 000. All units in existence in October of the reference year —
a snapshot — are included. Enterprise creations after this date are included only
if they have more than 50 employees.

Size class 0

This represents enterprises without salaried employment. In principle they are all
considered as no threshold is applied. Estimates for size class 0 of the number
of enterprises, turnover and value added were carried out by Statistics Sweden.

Size class D (and even size classes 1-8 and 10-19) is sometimes difficult to
identify because:

* it is often based on very small samples and a very detailed kind-of-activity
code;

* in Sweden there are companies operating within a group of companies
where the staff is employed by one enterprise but is actually working in
another. Therefore, there are enterprises with very large incomes but no, or
very few, employees.

Thus, size classes 0, 1-9 and 10-1¢ are not published separately but in an
aggregated band: 0-19.
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Variables

1. Number of units: number of enterprises.

2a.  Total employment: not available.

2b. Salaried employment. average number of employees during the financial
year. Both full and part-time employees are included, calculated in man-
years. Non-salaried empleyment is not included.

3. Turnover. total turnover in gross acceunts including rents and fees. It
excludes VAT and other indirect taxes, internal deliveries, returns and
discounts.

4. Value added: adjusted gross operating margin which corresponds in the

national accounts to the gross naticnal product at factor cost adjusted by
price charges {i.e. capital gains or loss) on stocks.
5. Labour cosls,
Government grants {e.g. to theatres or recreational services) are included in the
value added figure, but not in the turnover figure.

Classification

Economic sector: expressed in the Swedish nomenclature SNI (equivalent to
{8IC 1968 at four digits) at the four digit level with some aggregated codes. The
conversion into NACE 70 was carried out by Eurostat, attaining three digits of
the NACE, but ISIC codes which were already aggregated in SNI led to the
aggregation of NACEs at three and two digits. The activity of the enterprise
accounting for the largest share of employment is considered the main activity.

Sectoral coverage: all non-financial enterprises in the corporate sector. Both
private and public enterprises are included, regardless of their legal status or
size. Certain ISIC codes are absent from the tables:

* some activities only exist at the local unit level, not at the enterprise level as
main activities: ISIC 2902 {chemical and fertilizer mineral mining), 2903
(salt mining) and 7115 {pipeline transport};

* the financial sector and related activities — not covered by the EFA survey
(ISIC 8101, 935, 839, 953 and 96);

* Real Estate activities (I1SIC 831) are not covered either.

Employment size class: expressed in average number of salaried employees:
0-18, 20- 99, 100 - 199, 200-499, 500 +.

Users should be aware that employment figures only refer to enterprises with at
feast one employee (size class 1-19), while the rest include class 0.

Monetary unit

Data were supplied in thousands of Swedish kroner (SKR). Conversion into ECU
was carried out by Eurostat, the exchange rate being:

ECU 1 = 8KR 7.53285 (1992).
Confidentiality

Data considered confidential transmitted by Statistics Sweden have been treated
by Eurostat to prevent their disclosure.



EY%

United Kingdom

Sources

Consultants Graham Bannock & Partners provided the data, having submitted
official statistics to extensive estimates,

Sources were:

1. The VAT register from the Department of Trade and Industry (DTl) is the
main source. This covers all VAT registered units, excluding central and
local government but including public corporations, sole proprietorships,
partnerships and incerporated businesses. The optional threshold for VAT
registration was UKL 25 400 for the financial year 1990-81 and UKL 35 000
for 1991-92. Below this threshold estimates were carried out by Graham
Bannock.

2. The Annual Census of Production (ACOP) which covers all establishments
with 100 + employees and Is based on samples for the rest. The census is
used firstly to estimate average employment (in corder to transform the
turnover size classes into employment size classes) and then to add second
digit data (class level) to divisions 2-4.

3. The Census of Employment which records all active units in April plus those
newly created. The reference unit is the employer, size class 0 is excluded.

4. The annual Labour Force Survey which provides for quarterly estimates of
the self-employed, at the one digit level of the NACE.

5. The Inland Revenue who supply information on the average number of
partners per partnership; this is necessary for class 0 estimates.

6. Others, such as The Times 1000 database on the largest UK firms, the
Leyshon Report and employment figures from the Central Statistica! Office
(CS0). These data identify the private sector and public corporations from
central and local government.

Reference year(s)

1990 and 1991,

Reference unit
An estimate derived from the VAT unit, but not always directly comparable

with the enterprise: a snapshet of the register (VAT units) plus the self-employed
not registered for VAT,
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Size class 0

This represents the self-employed with no employees whether registered for VAT
or not {estimated).

Size class 0 cannot be given separately from size class 1-9, hence 0-9.

Variables

1. Number of units: enterprises as derived frem the VAT unit.

2 a. Total employment. average number of persons employed during the year.
2 b. Salaried employment: not available,

3. Turnover: totals invoiced by the enterprise during the reference year.
Available for industry and censtruction (NACE 1- 5) but not for services.

4. Value added: not availzble.

5. Labour costs: not available.

Classification

Economic sector: expressed at the one or two digit level (NACE 70), result of
the conversion from the VAT codes and SIC nomenclature: divisions 1, 2-4 (at
two digit level), 5, 6, 7 {class 71/79, rest of 7), 8 (class 83, class 85, rest of 8), 9
{class 91-86, class 97-99}. The main activity is determined by the assessment of
the entrepreneur himself.

Sectoral coverage: all market services, both private and public, are covered with
the exception of NACE class 85 {letting of real estate by the owner).

Employment size class: expressed in total number of employees. Size class 0
and 1 are taken together, resuiting in the following size class: 0-9 employees.

The following size breakdown is available:
0-8, 10-18, 20-49, 50-99, 100-199, 200-243, 250-499, 500 +.

Monetary unit

Data supplied in pounds sterling, the exchange rates being:

ECU 1 =UKL 0.71386 (1990)
ECU 1 =UKL 0.70101 (1991).

Confidentiality

Ne data are confidential.

Territorial coverage

The United Kingdom (Great Britain and Northern Ireland),
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EY
Iceland

Sources

The Statistical Bureau of Iceland provided data using the tax register, which
contains the tax returns of all enterprises, including their annual accounts as wel|
as special wages/femployment returns. The data transmitted to Eurostat are
based on wage and salary statements from the tax authorities.

Reference year(s)

1992.

Reference unit

The enterprise.

Size class 0
There are two size classes 0: 0 and 0A.

Size class 0: individual firms without employees (no wage payments other than
the owner's wages), i.e. self-employed with no employees.

Size class 0A: sole proprietorships with registered activity of owner (not
necessarily amounting to one man-year) and one or more employees (who may
work less than full-time, or only part of the year}. The owner is counted as one of
the persons emplayed only when there are working weeks registered in his name
on the salary statement.

Variables

1. Number of units: number of enterprises.

2 a. Total employment. number of persons employed measured in man-years
(52 working weeks per year). Employers are to report annually the number
of weeks worked by the employees, or by the self-employed themselves. [t
covers both the full-time and part-time positions according io the length of
their employment.

2 b. Salaried empioyment. not available.
Turnover. not available.
4,  Value added: not available.

Labour costs: defined as wages and salaries plus calculated owner's
income. As employment refers to the number of man-years it may include
labour costs for size class zero.



Classification

Economic sector: expressed in ISIC at the five digit level. A conversion into
NACE 70 divisions 1 to 9 at the two digit level was carried out by Eurostat.

When the enterprise is involved in more than cne activity, the main activity is
determined by the highest sum of wages and salaries. In the wage and salary
statements, employers report the number of weeks worked by employees in any
branch of activity. If the same person is also emplayed in another activity,
hefshe will be credited with extra weeks for that one.

Sectoral coverage: the 1SIC (Rev. 2). There is no information based on the
enterprise for the following: whale processing (30312), manufacture of tobacco
products (31220), construction and repair of harbours and fighthouses not
contracted away (50432). Otherwise all non-agricultural sectors are covered.

Employment size class: expressed in rounded off man-years of total
employment.

The size classes are;
0: self-employed persons without employees
0A: self-employed persons with one or more employees

and 1-9, 10-19, 20-49, 50-59, 100 +.

Confidentiality

No data transmitted by the Statistical Bureau of Iceland are confidential.

Remark

Additional comment concerning the employment figures (full and part-time
warkers), counted as man-years: a labour force sample survey carried out in
iceland showed that 71% of workers work full-time (90% of the active men and
48% of the active women are in this category). The rest are employed pari-time
(23%), have occasional work (2%) or have unspecified work-hours (4%).
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EY

Liechtenstein

Sources

The Economic Office provided the data for Liechtenstein. The source is the
Census of Enterprises conducted by the 'Bundesamt flr Statistik’ (Swiss Federal
Statistical Office) in co-operation with the Economic Office.

Reference year(s)

1981.

Reference unit

This is the local unit. The reference date is 30th September 1991,

Size class 0

Not available.

Variables

1. Number of units: active local units.

2 a. Total employment: not available.

2 b. Salaried employment: number of employees working in the local unit on
30th September 1991.

3. Turnover: not available.

4.  Value added: not available.

5 t abour costs: not available.

Classification

Economic sector: as declared by the enterprise, expressed in the Swiss
activity nomenclature (ASWZ 85) at the four digit level. Conversion to NACE
was carried out by Eurostat at the two digit level.

Sectoral coverage: all industries and services.

Employment size ¢lass: expressed in terms of salaried employment. Assigned
according to the number of employees on 30th September of the reference year.
Size class 0 is not available and size classes 6 and 7 are joined resulting in the
following size class: 200-499 employees.

Available size classes are:
1-8, 10-19, 20-49, 50-93, 100-189, 200-499, 500 +.

Monetary unit
ECU 1 = BFR 1.77245 (1981).
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EY

Norway

Sources

The Nerwegian Central Bureau of Statistics provided the data using the Central
Register of Establishments and Enterprises. This register is based on and up-
dated with surveys and information held in two other registers: the Value Added
Tax Register and the Register of Employers.

1. Surveys: most'enterprises are subject to some kind of survey each year.
Apart from surveys, e.g. on industrial statistics, simple questionnaires are
sent to the rest of the registered units.

2. The Value Added Tax Register, in the Directorate of Taxes, lists all new
activities subject to registration. With few exceptions, VAT registration is
compulsory for all enterprises with establishments which have an expected
annual turnover of at ieast NKR 12 000.

3.  The Register of Employers, in the National Insurance Office, contains
information on all new employers whe have to register thefr activity.
Reference year(s)

1981 and 1992.

Refarence unit

The enterprise. The legal institutional unit comprising all the economic activities
engaged in by one and the same owner, and covering one or more productive
units {establishments).

No minimum period of activity is required for an enterprise to register, in that

respect they are all included in the population. However, a minimum annual
turnover of NKR 12 000 {approximately ECU 1 500) is required.

Size class 0
This covers enterprises where the equivalent of less than half a man-year is

worked. Class 0 is not fully covered for all activities. Enterprises with less than
one man-year are not included in the table for employment.
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eurcstat

Norway (continued)

Variables

1. The number of units: the number of enterprises registered at the end of the
reference year.

2 a. Total employment: number of salaried and non-salaried persons employed,
calcutated in man-years.

2 b. Salaried employment: not available.

3. Turnover: total annual amount of Gross Production Value.
4, Vealue added: not available.

5.  Labour costs: not available.

No information on total employment and turnover is provided for the following
activities: electricity, gas and water supply, railway transport, provision of
tramway and subway transport, harbour administration, lighterage and pilotage
services, air transport, communications, financial institutions, public admin-
istration and defence, sewage disposal, social and related community services,
recreation and cultural services.

Classification

Economic sector: data were supplied in the ISIC Rev. 2 nemenclature up to the
five digit ievel. Conversion to the NACE 70 nomenclature was carried out by
Eurostat, obtaining a three and sometimes two digit level of classification. If
there is more than ene activity, the criterion used to assign the main one is the
number of man-years.

Sectoraf coverage: all non-agricultural market sectors are included except ocean
transport vessels, letting of residential and other buildings, some cultural
services, domestic services, international and other extra-territoriai bodies.

Employment size class: an additicnal size class option is included, namely 'not
reported’. This category mainly contains enterprises registered as new in the
reference year, for which no infermation is available on empleyment/turnover.

Monetary unit

Data were supplied in thousands of Norwegian kroner {NKR), the exchange rate
being:

ECU 1 = NKR 8.01701 (1891)
ECU 1 = NKR 8.04177 (1992).

Confidentiality

Confidential figures have been blanked out by the Norwegian Bureau of
Statistics.
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EY%

Switzerland

Sources

The Bundesamt fir Statistik (Swiss Federal Statistical Office) provided the data
for Switzerland.

its source was the Census of Enterprises. This census is conducted every 10
years in years ending with a 5 {1985, 1995, etc.). Intermediate censuses are
carried out two or three times during the 10-year period. These include less
variables and are exhaustive for units with at least one employee and sampled
for class 0. The census used here is an intermediate one, dated 30th September
1991. As the census is mandatory the response rate is amost 100%.

Reference year(s)

1591,

Reference unit

The enterprise.

Siza class 0

Size class O represents all enterprises without employees. This size class was
estimated from a sample and is joined with size class 1 (1-9 employees)
resulting in size class 0-9.

Variables
1. Number of units: all active enterprises on 30th September 1991,
2 a. Total employment. nat avallable.

2 b. Salaried employment: number of employees working in the enterprise on
30th September 1951,

3. Turnover. not available.
4, Value added. not available.

5 Labour costs: not available.
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eurostat

Switzerland (continued)

Classification

Economic sector: as declared by the enterprise, expressed in the Swiss activity
nomenclature (ASWZ 85} at the four digit level. Conversion to the NACE
divisions 1 to 9 was carried out by Eurostat attaining the three digit level.
Sectoral coverage: all industries and services.

Employment size class: expressed in terms of salaried employment. Assigned
according to the number of employees on 30th September of the reference year.

Employment size classes 0, 1 and 6, 7 are joined resulting in the foilowing size
classes:

0-9, 10-19, 20-46, 50-89, 100-199, 200-498, 500 +.

Monetary unit
Data supplied in Swiss francs, the exchange rate being.

ECU 1=58FR 1.77245 (1891).

Remark

As a result of the conversion from the ASWZ nomenclature to NACE 70, some
sectors may not always match precisely the NACE threeftwo digit levels.
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Installation procedure for CUB.X and the SME database
(CUB.X version 1.0 - SME diskette version 1.0)

1. About CUB.X.

1.1. CUB.X is the property of the European Commission. i has been produced by Eurosiat.
This software may be used by you ree of charge, but cannot be resold. it may nol be used
for commercial purposes o dishibuted withoul price authorisation by Eurostat,

1.2. For move nformation, questions, remarks and 1o receive the official release please contact:

EURDOSTAT DATA SHOP
2 rue J. Engling
L-1466 Dommeldangs
Tel (4352} 433522 51
Fax {(+352) 43 35 22 221
Far questions concarning CUB.X_ pleasa contact Mr. Tayenne,
Tel (+352) 4301 37267

2. Content of the diskettes
One diskette containing the CUB.X software and ohe containing the SME database.
3. What you need to run CUB.X for SME data
- PC 488 {CUB.X for Win runs on a PC 386 but slowly ...}
- WINDOWS version 3.1 (or later)
- At least 15 Mbytes on your hard disk
N.B. CUB.X has not beon fested on 08/2
4. How to install CUB.X and the SME database
4.1. Installation of CUB.X on the hard disk.
- load WINDOWS, siart the file manager
- insert the CUB X dikette in the disk drive
- goto disk a: {or whichever drive you placed the CUB.X diskette in)
- run the SETUP.EXE file,

You will be guided through the installation procedure. During the procedure files will be
decompressed.

4.2 instaliation of the SME database on the hard disk.

- load WINDOWS, start the file manager

- insert the SME disk in the disk drive

- go fo disk a: {or whichever drive you placed the SME diskette in)

- run the SETUP.EXE file.
You will be guided through the installation procedure. Duwring the procedure files will be
decompressed. ’

5. Running SME

Torun SME database simply double dick on the New Cronos Products group icon in the
WINDOWS screen. Then double click or: the SME /Ewrostat icon. You are then in the SME
database using the CUB.X Browser.
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Enterprises in Europe, Fourth Report

What is the role of Small and Medium-sized Enterprises in the EU?

How many people are employed in EU enterprises and how much turnover
do they generate?

¢ Inwhich countries are enterprises particularly big or small?

The importance of SME's for growth and employment has been siressed for
years. SME's represent over 90% of all enterprises in the EU. Therefore a
European policy for SME's needs reliable and comparable enterprise data for all
Member States.

The publication Enterprises in Europe, Fourth Report provides not only the
general methodology of the SME data, but also a set of specific analyses on
different subjects:

¢ & genaral overview of enterprises in the EL,

¢ specific analyses such as the creation of new firms, the innovation
behaviour and labour costs of SME’s, regional analyses, efc.;

¢ a snapshot of the business structure of 16 European countries and 27
economic sectors.
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This package contains:
One diskefte containing the CLUB.X software and one diskette containing SME
data. Also included is a CUB.X quick reference manual and fable notes by
country.

Export formats:
Table: DIF,EXCEL / TAB,CSV. Stream: DBASE, TEXT,CSV.

What you need to run Enterprises in
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- At least 15 Mbytes on your hard disk.
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